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1 Introduction

1.1 Overview of AliveMon

1.1.1 AliveMon

Adiscon AliveMon is a network management tool that is easy to use, produces
useful information everyday, and provides a system-level view of the
network. It helps to monitor the hosts in a network and also includes utilities
to do port discovery, port scanning, trace routing and much more.

AliveMon is the latest product by Adiscon. It has a user-friendly, graphical interface
for performing different tasks.

With AliveMon, home users and network administrators can easily watch what is going
on with the network hosts/devices. It also enables security administrators to find
weak spots and aids in detecting intrusions as well as forensic analysis.

If you would like to contact Adiscon, please email us at support@adiscon.com for
technical questions and info@adiscon.com for all others.

1.1.2 Features

Network Discovery

AliveMon is powered with network discovery wizard that helps to discover hosts
available in the network.

Addition of Hosts

You can easily add hosts/devices available in your network to AliveMon and monitor
them.

Addition of Monitors

You can add monitors to the hosts/devices in AliveMon. Monitor can be a TCP, HTTP,
Ping or UDP.

Add Actions

You can add customizable actions to each of the added device. There are different
actions available in AliveMon like Play Sound, Send Email, Send Syslog, Window
Popup, Start Program and so on, depending upon the nature of event occured.

Ports Discovery

You can discover the ports available in your added host and also get to know about
the services running on those ports.
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Port Scanning

You can analyze hosts/devices and different services running on them. Port scanning
accurately determines the active services on a specific network device/host.

Trace Route

You can determine the route packets take to reach a particular host by sending ICMP
echo packets with varying IP Time-To-Live (TTL) values to the destination. It can be
used to determine where a packet stopped on the network. It is useful for
troubleshooting networks where several paths can be taken to arrive at the same
point, or where intermediate systems (routers or bridges) are involved.

Speech Action

AliveMon can also talk/speak with speech action.

Debug Logging Options

You have multiple debug logging options.

Zero-Impact Monitoring

AliveMon has no noticeable impact on system resources. It is specifically written with
minimal resource usage in mind. In typical scenarios, its footprint is barely traceable.

Ease of Use

AliveMon is easy to install and configure. Comprehensive step-by-step guides and
wizards help users with setting up the application.

Friendly User Interface

AliveMon has a nice and decent user interface.

2 Getting Started

2.1 Setup

2.1.1 Installation of AliveMon

Installing AliveMon is simple and easy.

This Chapter describes the Installation without Microsoft .NET Framework 2.0 installed
on your Machine.
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Figure 1: Self-Extracting Components of .NET 2.0

Figure 2: Installation and configuration of .NET Framework 2.0
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Figure 3: Starting the AliveMon Installation after successfull .NET FW Setup

Figure 4: Accept AliveMon License Agreement
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Figure 5: Enter your Data

Figure 6: Here you can change the Installation Path
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Figure 7: Installation Content Wizard

Figure 8: Starting the Installation of AliveMon
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Figure 9: AliveMon is installing ...

Figure 10: Setup of AliveMon finished. You can now launch it. Usually you see Figure
11.

Figure 11: You must restart your Computer now. AliveMon should run without the
restart, too, but some features definately need a restart in order to work properly.

NOTE: If you are using WinXP/2k you can receive the Error, described in the following
FAQ:
http://www.alivemon.com/en/faq/why-not-compatible-with-winxp2k.php

http://www.alivemon.com/en/faq/why-not-compatible-with-winxp2k.php
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2.1.2 First Start of AliveMon

After installation, you have to run AliveMon from this installation directory or any
other shortcuts you make.

Now in this folder, click the file named AliveMon.exe and the setup starts. A screen
similiar to the one shown in figure 1 displays:

Figure 1: AliveMon installing

You also get an option to discover your network when you install AliveMon for the first
time as shown below:
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Figure 2: First time Network Discovery Wizard

Note: If you do not want to discover your network at the time of first time install, you
just click Finish and get back to this wizard by going to File -> Network Discovery in
running AliveMon.

After the installation is completed, you enter into AliveMon running interface as shown
below:
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Figure 3: AliveMon running

How you want to discover your network?

Scan Windows Network

Scan IP Range

Resolve Names using DNS during Scan operation

If this option is checked IP addresses are resolved to respective host names during
scan operation.

2.1.3 Scan Windows Network

When you want to scan the Windows network, you have to select Scan Windows
Network as shown below:
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Figure 1: Scan Windows Network

After sometime AliveMon comes up with the list of domains / workgroups available in
your network as shown below:
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Figure 2: List of Domains/Workgroups

Now you have to select the domain or work group you want to scan and click Next.
When you do this AliveMon starts doing domain or work group scanning as shown
below:
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Figure 3: Network Discovery Wizard

AliveMon discovers machines in the domain or work group, below is the AliveMon
interface while domain scanning.
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Figure 4: Network Discovery Wizard Running

Once the machines in the specific domain or work group are scanned, you click Next
or Finish and sees the hosts added in the host list as shown below:
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Figure 5: Added Hosts List

2.1.4 Scan IP Range

When you want to scan the network hosts within a specific IP range, you have to
select Scan IP Range option as shown below:
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Figure 1: Scan IP Range

Click Next and enter the End IP Address of your IP range. Typically the Start IP
Address of your network is automatically picked up by the application. You can
change it as well.
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Figure 2: Specify IP Range

When you click Next, the scanning process starts as shown below:
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Figure 3: Network Scanning in Progress

Once the scanning is done and you click the Finish button, you see the discovered
hosts list as shown below:
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Figure 4: Added Hosts List

2.1.5 Obtaining a Printable Manual

A printable version of the manual can be obtained at
http://www.alivemon.com/en/Manual/

The manuals offered on this web page are in PDF format for easy browsing and
printing. The version on the web might also include some new additions, as we post
manual changes – including new samples – frequently and as soon as they become
available.

3 Using AliveMon

AliveMon is a simple application to use.
It is powered by an easy to navigate user interface and context
sensitive help.

http://www.alivemon.com/en/Manual/
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3.1 Add Host

When you click on Add in Hosts menu, the following window form opens up:

Figure 1: Add Host

Enter the IP Address or Hostname of the new entry

Under this heading in yellow box, you have to specify the IP address or host name of
the machine you want to add.
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Figure 2: Insert Host IP Address

After the host is added

Under this heading, you choose actions that you may like to carry out as soon as the
host gets added to the application.

Start Port Discovery

If you select this option, application starts discovering the ports for the added host
just after the authentication of its validity.

Figure 3: Port Discovery

Open Advanced Configuration

If this option is selected, it opens up the advanced configuration interface for the
added host. A screen similiar to the one shown below displays:
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Figure 4: Host Advanced Configuration

3.2 Port Discovery

In Hosts menu, if you click Port Discovery after selecting some host or you right click
any of the host entry and click Port Discovery, application starts discovering ports of
that particular host.

Figure 1: Port Discovery

After the ports are discovered you can add monitors by clicking the Add Monitors
button, this takes you to the advanced configuration interface.
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Figure 2: Port Discovery

Ports discovered are displayed with their numbers, descriptions, time and type of
monitors running. Details button can be used to Hide/Unhide the details.

If you click on Add Monitors button, it takes you to the advanced configuration options
interface for the host.
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3.3 Network Discovery

If you click File -> Network Discovery, you see a form similar to the one shown below:

Figure 1: Network Discovery Wizard

How you want to discover your network?

Scan Windows Network

Scan IP Range

Resolve Names using DNS during Scan operation

If this option is checked IP addresses are resolved to respective host names during
scan operation.
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3.4 Default Actions

When a monitor fails, or restores its state from fail to success, the "Default Actions"
are executed. If you click File -> Default Actions, you see a form similar to the one
shown below in Figure 1:

Figure 1: Default Actions

Right now, the default actions list is empty. You can add an action by clicking on the
Add button. Once you click on Add button, the following screen opens up:
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Figure 2: Add Action

Which type of Action would you like to add?

There are four types of actions that you can add, these are shown in the figure below:

Figure 3: Types of Actions

WinPopup Action

This action sends a popup message to a configured target using Windows messenger
service.

PlaySound Action

This action plays a sound if certain event or state occurs.

SendEmail Action

This action sends an email if certain event or state occurs.
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StartProgram Action

This action executes a program or exe file if certain event or state occurs.

Initial Name of the Action

It is to specify the name of the action.

Default Actions list

Figure 4: Default Actions list

Once you have some actions in the list, you can Edit, Delete and also change their
display order with up and down arrows.
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3.5 Advanced Configuration

To enter into advanced configuration interface for a particular host, you can do one of
the following things:

1. Select 'Open advanced configuration' when adding a host using add host form.
2. Double click the host entry in the added hosts list.
3. Right click on any of the added host entry in the added hosts list and select Edit.
4. Click Add Monitors button, once the ports are discovered.

Figure 1: Added Host List View

3.5.1 Options

3.5.1.1 General

When you come to Options, by default you see the General options and get a window
as shown below:
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Figure 1: General Options

Hide on Startup

If this option is checked, AliveMon cannot be seen on desktop tray at system startup.

Hide when the Main windows is closed

If this option is checked, quitting the application also removes the application icon
from the desktop tray.

Load AliveMon on Windows Startup

It is now possible to let AlivMon load up togheter with Windows.

Debugging

Under this group box, you see the following options:

Enable Debug Window

If this option is checked, it displays a debug form window as shown below:
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Figure 2: Debug Form

Enable Debug Logging into file

For debug logging, you have to check it. It is helpful when you are experiencing some
problem, you just generate a debug log file and send it to us. It is very helpful in
diagnosing the problem.

File and Pathname

Here you have to provide the path of the generated debug log file if you have checked
the 'Enable Debug Logging' into file option.

Delete old debuglog on startup

If this option is checked, it deletes the old debug log from the debug file at system
startup.
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3.5.1.2 Questions

Once you click on Questions tab, you see a window as shown below:

Figure 1: AliveMon Questions option

Always prompt for Saving before an Action can be tested

If this is checked, you always get a prompt for saving before an action is tested.

Show warning before a host entry is deleted

If this option is selected, you get a warning before deleting a host entry.

Show notification when an Actiontest is complete

This option will show you a small windows with a message if the Action was correct or
what you did wrong.
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3.5.1.3 Network/Port Discovery

When you click on Network/Port Discovery tab, you see a window as shown below:

Figure 1: AliveMon Port Discovery options

Every Port in the portlist

If this option is checked, application scans all the ports listed in the port list. You can
view the port list by clicking on Portlist Setup button.

Selected Ports from the List

If this option is checked, application only scans the selected ports from the port list.
To check the ports click on the Portlist Setup button.

All ports from

This option is used to specify the range of ports you want to scan.

Portlist Setup
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When you click on this button, it opens up a PortScan ListEditor as shown below:

Figure 2: AliveMon PortScan ListEditor

Once you select or deselect the ports, do not forget to save the changes in the
PortScan ListEditor by clicking the Save button.

Automatically start scanning

If this option is checked, application start scanning ports on startup automatically.

Connections

It is used to specify the number of connections.

AutoStart when TraceRoute Window is opened

If this option is checked, AliveMon starts trace route without the need of clicking
"Start" again, when you open the TraceRoute Tool.

AutoStart when PortScan Window is opened

If this option is checked, AliveMon starts port scanning without the need of clicking
"Start" again, when you open the PortScanning Tool.
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3.5.1.4 License

AliveMon does not offer a free license for one host anymore. This means you will have
a full featured 30 days trial time for AliveMon. Once you get the license information
and click License tab, you see a form as shown below:

Figure 1: License Form

Add from Clipboard

You can copy a sent alivemon-key to your clipboard using Ctrl+C or rightklick->Copy.
By clicking this button, The program itself enters the License Information.

Add

Add your License Informations manually.

Edit

Edit your License Informations.

Delete
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Delete a License.

Figure 1: License Form

License name

Here you provide the name of the individual/organization to whom the license has
been issued.

License Key

Here you provide the license key that is supplied to you by Adiscon with your license
name. AliveMon now doesn't come with a free license anymore. You have the
standard 30 day trila fa

Note: If you do not have license and you open up this form, please click the link on
this screen to purchase AliveMon.
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3.5.2 General

When you are in advanced configuration interface, by default you see a form that
deals with adding general information related host/device, you see a window form as
shown below:

Figure 1: Advanced Configuration Interface - General

Display name

Here you can specify the display name of your host/device as shown below:

Host name (DNS Name)

Here you specify the host name and also verify it from your DNS by using Verify
button present in front of the text field.

IP Address

Here, you get the IP address of the added host. You can also verify it from your DNS
by using Verify button in front of the text field. Once you click Verify and you have
added a valid IP address, you receive a message window as shown below:
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Figure 2: Valid IP Address Message

Device Type

Here you select the type of your device whether it is a Router, Server, Work station,
Desktop or Laptop.

Use DNS-Name for host resolution

If this option is checked, DNS name is used for host resolution.

Show Popup Warnings in Tray Window

If this option is checked then you see Popups related to the added hosts/devices.
Sample shown below:

Figure 3: Popup Window

NOTE: What you see already in General advanced configurations form depends upon
your input in Add Host form i.e. whether you give an IP address or host name.

Description

Here you can add description for your added host.
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3.5.3 Monitors

If you want to Edit an existing, or create a new Monitor, rightclick on a Machine ->
Edit -> Monitors and you will see a form similar to the one shown below in Figure 1:

Figure 1: Default Monitors

You can add a new Monitor by clicking on the Add button. Once you click on Add
button, the following screen opens up:
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Figure 2: Add Monitor

Which type of Monitor would you like to add?

There are four types of Monitors that you can add, these are shown in the figure
below:

Figure 3: Types of Monitors

Ping Monitor

The PING Monitor uses the ICMP Protocol to send a ICMP_Echo to the configured host.

TCP Monitor

Use this monitor if you want to monitor TCP based Services like POP3, FTP or NNTP.

HTTP Monitor

The HTTP Monitor is specialized for HTTP based Services. It is based on the TCP
Service, and additionally use the http protocol to query the webserver.

UDP Monitor

UDP Services are usually very difficult to monitor due the nature of the UDP Protocol.
However there are many services, specially gameservers, who respond on UDP
requests and so can be monitored.
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3.5.3.1 Ping Monitor

The PING Monitor uses the ICMP Protocol to send a ICMP_Echo to the configured host.
Please note that the target has to allow ICMP, otherwise the PING Monitor will not
work. So if the host you want to monitor is using a Firewall for example, make surre
the Firewall allows ICMP traffic for you.

Monitor Name

This is the name that you specify at the time of adding action in the 'Initial Name of
the Monitor' field.

Monitor Comments
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Here you can add a description or write down some Comments for the added Monitor.

Polling frequency

Defines the interval of how often the Monitor does perform it's checks.

Minimum failed times

If the Monitor check fails for the count of minimum failed times, an alert will be
generated. The default is set to 2 which is a good setting to avoid false alerts.

Enable Flatfile Detailed logging

This setting will enable flatfile logging of the activity for this monitor. The logfile will
be stored in the logs directory of AliveMon. Please note that the logformat may
change in future versions.

Bytes to Send

How many garbage bytes are going to be send in the ICMP Echo request.

Timeout

Defines how long the ping will wait for an Echo reply.

3.5.3.2 TCP Monitor

Use this monitor if you want to monitor TCP based Services like POP3, FTP or NNTP.
The TCP Monitor treats an opened connection as success.
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Monitor Name

This is the name that you specify at the time of adding action in the 'Initial Name of
the Monitor' field.

Monitor Comments

Here you can add a description or write down some Comments for the added Monitor.

Polling frequency

Defines the interval of how often the Monitor does perform it's checks.

Minimum failed times
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If the Monitor check fails for the count of minimum failed times, an alert will be
generated. The default is set to 2 which is a good setting to avoid false alerts.

Enable Flatfile Detailed logging

This setting will enable flatfile logging of the activity for this monitor. The logfile will
be stored in the logs directory of AliveMon. Please note that the logformat may
change in future versions.

TCP Port

The Port that will be monitored by the Monitor.

Timeout

Defines how long the Monitor will wait for TCP Connection.

Send a message and check for an expected message

If this option is enabled, the TCP Monitor will also send and receive an message once
a connection is made. And only if the received messages matches the configured one,
it will report success.

Message to Send

Defines which message you want to send once a connection is made.

Message to Expect

Defines the message you expect as answer from the target host. You can also only
use a part of the complete message to compare.

3.5.3.3 HTTP Monitor

The HTTP Monitor is specialized for HTTP based Services. It is based on the TCP
Service, and additionally use the http protocol to query the webserver.
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Monitor Name

This is the name that you specify at the time of adding action in the 'Initial Name of
the Monitor' field.

Monitor Comments

Here you can add a description or write down some Comments for the added Monitor.

Polling frequency

Defines the interval of how often the Monitor does perform it's checks.
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Minimum failed times

If the Monitor check fails for the count of minimum failed times, an alert will be
generated. The default is set to 2 which is a good setting to avoid false alerts.

Enable Flatfile Detailed logging

This setting will enable flatfile logging of the activity for this monitor. The logfile will
be stored in the logs directory of AliveMon. Please note that the logformat may
change in future versions.

HTTP Port

Define the http Port you want to monitor. Usually this is Port 80.

Timeout

Defines how long the Monitor will wait for TCP Connection.

URL_Query String

This will be the website & Query String which will be requested by the HTTP Monitor.

Request Type

You can choose between GET and HEAD. HEAD is recommended as it will only receive
the http header of a website and will help to reduce traffic used for  the monitoring.

Referer

Optional value which you can configure, this will set the Referer URL that will be seen
in the Servers http logfiles.

UserAgent (Browser)

Also optional value to set the UserAgent Browser. You can customize this value if you
want to detect the HTTP Monitor in the Servers http logfiles.

3.5.3.4 UDP Monitor

UDP Services are usually very difficult to monitor due the nature of the UDP Protocol.
However there are many services, specially gameservers, who respond on UDP
requests and so can be monitored.
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Monitor Name

This is the name that you specify at the time of adding action in the 'Initial Name of
the Monitor' field.

Monitor Comments

Here you can add a description or write down some Comments for the added Monitor.

Polling frequency
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Defines the interval of how often the Monitor does perform it's checks.

Minimum failed times

If the Monitor check fails for the count of minimum failed times, an alert will be
generated. The default is set to 2 which is a good setting to avoid false alerts.

Enable Flatfile Detailed logging

This setting will enable flatfile logging of the activity for this monitor. The logfile will
be stored in the logs directory of AliveMon. Please note that the logformat may
change in future versions.

UDP Port

The Port you want to monitor over UDP.

Timeout

Defines how long the Monitor will wait for TCP Connection.

Select UDP Message to send

here you can select a predefined UDP Message you want to send. Usually these are
very binary related messages, so they may will not show correctly in the message
field. Note that most UDP Services will only send an answer back when the request
was correct.

I want to customize the UDP Message

If you need to customize the message you want to send over UDP, you have to enable
this option.

Check for the Message Content in the UDP Reply

Enable this option if you want to verify the response of the UDP request. This is
similar to the message content check in the TCP Monitor.

3.5.4 Actions

When you click on the actions link present on the right hand side of the window
frame, the screen similiar to the one shown below opens up:
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Figure 1: Actions Interface

It displays the actions associated with a particular host and dispalys information
related to action name, type and the state in which it has to be triggered.

If you want to add a new action, press the Add button and the following screen opens
up:

Figure 2: Add new Action

Which type of Action would you like to add?

There are four types of actions that you can add, these are shown in the figure below:
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Figure 3: Types of Actions

WinPopup Action

This action results in a popup window if certain event or state occurs.

PlaySound Action

This action plays a sound if certain event or state occurs.

SendEmail Action

This action sends an email if certain event or state occurs.

StartProgram Action

This action executes a program or exe file if certain event or state occurs.

Send Syslog Action

This Action sends a Message via Syslog. Here general options are also same as in
above actions.

Speech Action

This Action reads the configured text and speaks it.

WinPopup Action
PlaySound Action
SendEmail Action
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StartProgram Action
Send Syslog Action
Speech Action

3.5.4.1 WinPopup Action

When you select WinPopup action with 'Customize action after creation' option
checked the following window form opens up:

Figure 1: Customize WinPopUp Action

General Options

Under this group box, you see the following options:

Action Name

This is the name that you specify at the time of adding action in the 'Initial Name of
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the Action' field.

Action Description

Here you can add a description for the added action.

Fire for this State

Here you can select a state for which the action should be fired.

Insert Variable

Here you can select a Variable for i.e. the downtime or the Source System that you
can use in your Alert-Text.

Popup Destination

Here you specify the machine on which you like to have the popup's.

Enum from Network

This function fills the combo box with what it finds in your local network.
Unfortunately, this can consume some time depending on your network.

Configure the Message shown in the Popup Window

The text you are looking under this heading is customizable. There are some variables
present in this message. To view details about each of the variable, see variables
description.
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3.5.4.2 SendEmail Action

Here general options are same as in above actions.

Figure 1: Customize SendEmail Action

SMTP Server

Here you specify your SMTP server IP address or name.

SMTP Port

Here you specify SMTP port. Default SMTP port is 25.

SMTP Sender

Here you specify your SMTP sender IP address or name.
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SMTP Receiver

Here you specify your SMTP receiver IP address or name.

SMTP Subject

It is the subject format of your email message.

Configure the Email Message text

The text you are looking under this heading is customizable. There are some variables
present in this message. To view details about each of the variable, see variables
description.
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3.5.4.3 PlaySound Action

Here general options are same as in WinPopup action.

Figure 1: Customize Playsound Action

Use System Registered Sound

Here you can specify a Windows Sound to play.

Use Soundfile from Disk

Here you can specify the path of the sound file which you want to play.

Play sound more then once

If you want to play sound more then once, you need to check this box. Once you
check this box the below options are also enabled.
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Repeat the Sound for

Here you specify that how many times you want to repeat the sound file.

Pause between playing

Here you specify the time in milliseconds as a pause between the sound file
repetitions.

3.5.4.4 StartProgram Action

Here general options are also same as in above actions.

Figure 1: Customize StartProgram Action
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Program to execute

Specify the program or script you want to start here.

Working Path

Every program has a working path, by default this is the part from where it is started.
You can override this default path by setting another value here.

Parameters

The parameters you want to start the program with. You can use all common
variables here as well.

Startup Priority

Defines with which priority the program is started.

3.5.4.5 SendSyslog Action

This Action sends a Message via Syslog. Here general options are also same as in
above actions.
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Syslog Server

The Server where you want to send the Syslog message to

Syslog Port

The Port which your Syslog Server is using

Syslogtag

The Syslogtag Value of the Syslog message

Syslog Priority

Defines the Priority of your Syslog message
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Syslog Facility

Defines the facility of your Syslog message

3.5.4.6 Speech Action

In order to use the Speech Action, you must have the Microsoft Speech API 5.x be
installed. You can obtain the latest Version from the following link:
www.microsoft.com/speech/
Here general options are also same as in above actions.

Speech Volume

Defines the Volume level of the Speech.

Talk Rate

http://www.microsoft.com/speech/
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This defines the how fast the text is spoken. The value can be between -10(slow) to
+10(fast).

Voice

Set the voice that will be used by the Speech Engine. To obtain more free voices,
please visit: www.microsoft.com/speech/

Audio Output device

If you have more then one soundcard installed, you can select which one will be used
here.

3.5.4.7 Variables Description

When you need to customize the message that is to be shown in different actions
added in AliveMon, you see a message/text as shown under 'Configure the Message
...' heading as in figure 1 below:

http://www.microsoft.com/speech/
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Figure 1: Edit Action Message

You have different variables in the message that you are looking at in the figure,
these and some other avaiable in AliveMon action configurations are briefly explained
below:

Host / Device Specific Variables

These variables are related to host or device added to the AliveMon, these are
discussed below:

Device_DisplayName

It represents the reporting device/host display name that you mention while doing
host entry in general information.

Device_DnsName
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It represents the reporting device/host DNS name that is provided by the DNS while
host/device name resolution.

Device_IPAddr

It represents the reporting device/host IP address that is obtained by AliveMon while
network discovery or you provide yourself at the time of adding a host/device.

Device_Type

It represents the reporting device/host type that you specify while doing host entry in
General Information section.

Device_Description

It represents the reporting device/host description that you provide while doing host
entry in General Information section.

Device_Notes

It represents the notes related to reporting device/host that you added while doing
host entry in Notes section.

Monitor Specific Variables

These variables are related to monitors available in AliveMon, these are discussed
below:

Monitor_Name

It represents the name of the monitor that you supply in advanced configurations of
host under Monitors section for 'Initial Name of the Monitor' field.

Monitor_Type

It represents the type of monitor that you select in advanced configurations of host
under Monitors section for 'Which type of Monitor would you like to add' drop down.

Monitor_PollingFreq

It represents the polling frequency that you supply in advanced configurations of host
under Monitors section for 'Polling frequency' field.

Monitor_State
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It represents the state of the monitor that whether its up or down.

Monitor_DownSince

It represents the down time of the monitor that for how long it is down.

Monitor_LastDownTime

It represents the last downtime

Monitor Specific Variables

These variables are related to monitors available in AliveMon, these are discussed
below:

System_Date

It represents the system date on which the message is sent.

System_Time

It represents the system time at which the message is sent.

System_Name

It represents the system name that generates the message.

System_OSVersion

It represents the operating system version installed on the host that generates the
message.

System_OSPlatform

It represents the operating system name installed on the host that generates the
message.
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3.5.5 Notes

When you click on the notes link present on the right hand side of the window frame,
the screen similiar to the one shown below opens up:

Figure 1: Add Notes Interface

Write down Notes about this Entry

Under this you see a white text area, here you have to write description about the
added entry.

Note: To save this description about host you have to click OK. If you do not want to
add it then press Cancel and if you need to write something else from scratch click
Reset to clear the form.

4 Getting Help

In the event you experience problems, find here how to solve them.

Please note that all options (except priority support) are also open to evaluating
customers. So do not hesitate to try them. Help is available in English and German
language. Our local resellers may provide local language support. Please check with
them.
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Frequently asked Questions

For a current list of Frequently Asked Questions (FAQ), please visit
http://www.alivemon.com/en/FAQ/. The FAQ area is continuously being updated.

AliveMon Website

Visit the support area at  www.alivemon.com for further information. If for any reason
that URL will ever become invalid, please visit www.adiscon.com for general
information.

Support Forum

Share questions and answers with your peers! The forum is also monitored by Adiscon
support staff. To access the forum, point your browser at http://forum.adiscon.com.
.

Customer Support System

Our customers service and support system is available at
http://custservice.adiscon.com. With it, you can quickly open a support ticket via a
web-based interface. This system can be used to place both technical support calls as
well as general and sales questions. We would appreciate if you select the appropriate
category when opening your ticket.

Please note: the customer service system asks you for a userid and password when
you open it. If you do not have a userid yet, you can simply follow the "register" link
(in the text part) to create one. You can also open a ticket without registering first, in
which case the system will create one for you. You will receive the generated userid
as part of the email notifications the system generates.

Why using the customer support system? As you see further below, we also offer
support by email. In fact, email is just another way to create a ticket in the customer
support system. Whenever we reply to your ticket, the system automatically
generates an email notification, which includes a link to your ticket as well as the
answer we have provided. So for the most cases, you can use email, only. However,
there are some situations where the support system should be used:

· Email notifications do NOT include attachments. If we provide an attachment, you
must login to the ticket in order to obtain this. For your convenience, each email
notification contains an active link that allows you to login immediately.

· If you seem to not receive responses from us, it is a very good idea to
check the web interface. Unfortunately, anti-SPAM measures are being setup
more and more agressive. We are noticing an increasing number of replies that
simply do not make it to your mailbox, because some SPAM filter considered it to be
SPAM and removed it. Also, it may happen that your support question actually did
not get past our own SPAM filter. We try very hard to avoid this. If we discard mail,
we send a notification of this, so you should at least have an indication that your
mail did not reach us. Using the customer support system via its own web interface
removes all SPAM troubles. So we highly recommend doing this if communication

http://www.alivemon.com
http://www.adiscon.com/en/
http://custservice.adiscon.com
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otherwise seems to be distrubed. In this case, please remember that notification
emails may also get lost, so it is a good idea to check your ticket for status updates
from time to time.

Email

Please address all support requests to support@adiscon.com. An appropriate subject
line is highly appreciated.

Online Seminars

Adiscon offers a selection of online seminars. This selection is continuously being
expanded. All available seminars can be found at
http://www.adiscon.com/Common/SeminarsOnline/

Please note: Windows Media Player is required to view the seminars.

Phone

Phone support is limited to those who purchased support incidents. If you are
interested in doing so, please email info@adiscon.com for further details.

Fax

Please direct your faxes to

+49-9349-928820

Toll free in the US: 1-888-900-3772

with "+" being the international dialing prefix, e.g. 011 in the US and 00 in most
other countries.

Software Maintenance

Adiscon's software maintenance plan is called UpgradeInsurance. It offers unlimited
free upgrades and priority support during its duration. It can be purchased for a
period between 1 and 5 years.

To learn more about UpgradeInsurance, please visit

http://www.adiscon.com/Common/en/products/upgrade-insurance-details.asp

Non-Technical Questions

Please address all non-technical questions to info@adiscon.com. This email alias will
answer all non-technical questions like pricing, licensing or volume orders.

http://www.adiscon.com/Common/SeminarsOnline/
http://www.adiscon.com/Common/en/products/upgrade-insurance-details.asp
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Please note: we have increasingly often problems with too-agressive SPAM filtering,
resulting in loss of our replies. If you do not receive a response from us within two
working days latest, we highly recommend re-submitting your question via the
customer support system.

Product Updates

Please visit www.alivemon.com for information about new and updated versions.

5 Purchasing AliveMon

All AliveMon features can be used for 30 days after installation without a license.

The License

The end user license agreement is displayed during setup. If you obtained a ZIP file
with the product, there is also a file license.txt inside that ZIP file. If you need to
receive a copy of the license agreement, please email info@adiscon.com.

Pricing & Ordering

Please visit http://www.alivemon.com/en/intermediate-order.php to obtain pricing
information. This form can also be used for placing an order online. If you would like
to place a purchase order, please visit
http://www.adiscon.com/Common/en/OrderByPO.php to obtain details.

If you would like to receive assistance with your order or need a quote, please contact
info@adiscon.com.

6 References

Following links will help you in getting further information on AliveMon.

AliveMon Homepage

· www.alivemon.com

Frequently Asked Questions

· www.alivemon.com/en/FAQ

Support

· www.alivemon.com/en/support

http://www.alivemon.com
http://www.alivemon.com/en/intermediate-order.php
http://www.adiscon.com/Common/en/OrderByPO.php
http://www.alivemon.com
http://www.alivemon.com/en/FAQ
http://www.alivemon.com/en/support
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Product Tour

www.alivemon.com/en/product/product-tour.php

7 Copyrights

This documentation as well as the actual AliveMon product is copyrighted by Adiscon
GmbH, Germany. To learn more about other Adiscon products, please visit
http://www.adiscon.com/en/products. To obtain information on the complete
MonitorWare product line, please visit www.monitorware.com.

Microsoft, Windows, and the Windows logo are trademarks, or registered trademarks
of Microsoft Corporation in the United States and/or other countries.

Other mentioned trademarks are for reference only. They belong to their respective
owners.

8 Glossary of Terms

The Glossary of Terms is also available on the Web. Please check it from time to time,
as our websites are continously being updated. Our manuals are also updated with
each new version release. Since things change so frequently, it's better to be on the
safe side.

http://www.monitorware.com/Common/en/glossary/

8.1 Millisecond

A millisecond is a thousand of a second. It is abbreviated as "ms". As such, 500ms
mean half a second.
Inside the MonitorWare line of products, many timers are expressed in milliseconds as
a fine control over the services and actions is provided to the administrator.

Click here for more Information about Milliseconds.

8.2 MonitorWare Line Of Products

Adiscon's MonitorWare line of products includes monitoring and operations
management tools. It consists of several components, each of which can be used
either individually or as a complete solution. As of this writing, the following products
are available:

· Adiscon Logger (www.monitorware.com/en/logger/)
· ActiveLogger (www.activelogger.com)
· EventReporter (www.eventreporter.com)
· IISLogger (www.iislogger.com)

http://www.alivemon.com/en/product/product-tour.php
http://www.adiscon.com/en/products/index.php
http://www.monitorware.com/en/index.php
http://www.monitorware.com/Common/en/glossary/
http://www.monitorware.com/Common/en/glossary/Millisecond.php
http://www.adiscon.com/en/
http://www.monitorware.com/en/logger/index.php
http://www.activelogger.com/en/index.php
http://www.eventreporter.com/en/index.php
http://www.iislogger.com/en/index.php
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· MoniLog (www.monilog.com)
· MonitorWare Agent (www.mwagent.com)
· MonitorWare Console (www.mwconsole.com)
· WinSyslog (www.winsyslog.com)

There is also an open source syslog library available for programmers whishing to
integrate syslog into their C/C++ programs:

· Liblogging (www.liblogging.org)

New products are continously being added - please be sure to check
www.monitorware.com from time to time for updates.

Click here for more Information about the MonitorWare Line of Products.

8.3 TCP

A reliable IP transport protocol. TCP communication ensures that no packets are lost
in transit. As such, it is most useful in low-bandwidth or unreliable environments.
Examples are slow WANs or packet radio networks.

8.4 UDP

A non-reliable IP transport protocol. It provides best effort delivery. Typically, in LAN
environments UDP packets are never lost. However, in WAN scenarios or with heavily
loaded LANs, UDP packets might be lost.

Click here for more Information about UDP.

8.5 UpgradeInsurance

UpgradeInsurance is Adiscon's software maintenance plan. It offers free major
upgrades as well as priority support. UpgradeInsurance is available for all Adiscon
products and can be purchased for a period between 1 and 5 years.

Click here for more Information about Upgrade Insurance.

http://www.monilog.com/en/index.php
http://www.mwagent.com/en/index.php
http://www.mwconsole.com/en/index.php
http://www.winsyslog.com/en/index.php
http://www.liblogging.org
http://www.monitorware.com/en/index.php
http://www.monitorware.com/Common/en/glossary/MonitorWare-Line-of-Products.php
http://www.adiscon.com/Common/en/glossary/UDP.asp
http://www.adiscon.com/en/
http://www.adiscon.com/Common/en/products/upgrade-insurance-details.php
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